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Overview 
 
Data once deleted, is not removed from the hard drive completely. Unwanted information is left available, 

that can be easily recovered. BitRaser for File serves as an effective solution to this problem. It uses 

overwriting techniques to make the data unrecoverable. Memory is completely reusable after data erasing 

activity. 

 
Commands and tools provided by operating system do not delete the files permanently. Instead only their 

link to the file structure is deleted. Files must be deleted permanently to ensure full privacy and security. 

BitRaser for File securely erases system, application and internet traces from your system there by 

ensuring privacy to the sensitive data. Erase Now feature of the software erases drive, folders and files 

permanently making them unrecoverable by any means. 

 

What's new in this version? 

 Option to wipe data files with a single right-click. 

 

Key Features: 
 

 User friendly GUI. 

 Equipped with 17 world class erasure algorithms with 3 options of erasure verification (No 

verification, Random verification and Total verification). 

 Erases data from mapped drives in your system. 

 Option to search for a specific file using its name. 

 Erases Unused space to secure privacy and optimized use of memory (Supports FAT, exFAT, NTFS 

file systems). 

 Erases system activity traces to ensure privacy and improved system speed. 

 Erases installed application traces and Internet activity traces. 

 Option to create erasure list containing the names of files and folders that can be erased in a single 

step. 

 Option to schedule and view erasing tasks. 

 Option to set password protection on application. 

 Option to generate log report for future assistance. 

 Support for Windows 10, 8.1, 8, 7, Vista, XP, Windows server 2012, 2008, 2003. 

  



Installation Procedure 

Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements 

 Processor: Pentium Class 
 

 Operating System: Windows 10 / 8 .1 / 8 / 7 / Vista / XP 
 

 Memory: Minimum 256 MB 
 

 Hard Disc: 40 MB of Free Space 

Steps to install BitRaser for File 

 To install BitRaser for File, follow these steps. 
 

 Double-click BitRaserforFile.exe executable file to start installation. 'Setup - BitRaser for File' 
dialog box is displayed.  

 

 Click Next. 'License Agreement' dialog box is displayed. 
 

 Choose I accept the agreement option. 'Next' button will be enabled. Click Next. 'Select 
Destination Location' dialog box is displayed. 

 

 Click Browse to select the destination path where the setup files will be stored. Click Next. 'Select 
Start Menu Folder' dialog box is displayed. 

 

 Click Browse to provide path for program's shortcuts. Click Next. 'Select Additional Tasks' dialog 
box is displayed. 

 

 Choose the check boxes as per your choice. Click Next. 'Ready to Install' dialog box is displayed.  
 

 Review the entries. Click Back if you want to change them. Click Install to start installation. The 
Installing screen shows the installation process. 

 

 After completing the process, 'Completing the BitRaser for File Setup Wizard' window is 
displayed. Click Finish. 

 
Note: Clear Launch BitRaser for File check box before clicking Finish to prevent the software from 

launching.  

  



BitRaser for File Configuration Settings 

After you install BitRaser for File, a dialog box appears on the window prompting you to either Register 

the product or run demo version of the software. If you register the product, a configuration wizard is 

displayed which allows you to set Password Protection, Log File Path, Certificate Path, Erasing Algorithm 

and a Verification Method. These configuration settings can also be altered from the Tools menu of the 

application. 

To set Password Protection, follow these steps: 

1. In the Enter Password text box, type a password of minimum 6 alphanumeric characters. 

2. Retype the password in Confirm Password text box as illustrated below: 

 

 

 

3. Type a password hint of minimum 4 alphanumeric characters in Password Hint text box. 

4. Click Next to proceed. 

5. Password will be applied on BitRaser for File. 

To set BitRaser for File Configuration, follow these steps: 



1. From the Configuration window that appears, select Enable Logging option to create an activity 

log file. 

2. Click Browse. From the Browse for Folder dialog box that appears, select the desired path for 

saving the log file. 

3. Select the path for saving the certificate by clicking on Browse button. 

4. Select Erasure Algorithm and Verification method from their respective drop down boxes. 

 

 

 
5. Click Next to proceed. 

6. A message appears indicating the successful completion of the configuration process. Click 

Finish. 

 



 

 

Note: You may skip these steps and configure these settings using the Tools menu at a later time. 

  



Launching the Software 

To launch BitRaser for File in Windows 10: 

 Click Start icon -> All apps -> BitRaser for File -> BitRaser for File. Or, 

 Double click BitRaser for File icon on the desktop. Or, 

 Click BitRaser for File tile on the home screen. 

To launch BitRaser for File in Windows 8.1 / 8: 

 Click BitRaser for File tile on the home screen. Or, 

 Double click BitRaser for File icon on the desktop. 

To launch BitRaser for File in Windows 7 / XP: 

 Click Start -> Programs -> BitRaser for File -> BitRaser for File. Or, 

 Double click BitRaser for File icon on the desktop. Or, 

 Click BitRaser for File icon in Quick Launch. 



User Interface 

 

The main user interface of BitRaser for File is as shown below: 

 
 
The user interface contains menus and tabs & buttons which allows you to access various features of the 
software. 

  



Menus 

Home Menu 
 

Register 

Use this option to register the software after 
purchasing. 

Transfer License 

Use this option to transfer the license of the 

registered software to another computer. 

Update Wizard 

Use this option to check for both, latest minor 

and major versions available online. 

About 

Use this option to read information about the 
software. 

Erase All Now 

Use this option for complete system erasure. 

 

 

 
Schedule Menu 
 

Delete All Tasks 

Use this option to delete all scheduled erasing 
tasks. 

Activate All Tasks 

Use this option to set the state as activated for 

all scheduled erasing tasks. 

Deactivate All Tasks 

Use this option to set the state as deactivated 

for all activated erasing tasks. 

Scheduled Tasks View 

Use this option to view a list of all scheduled 

erasing tasks. 

 

 



Reset Scheduler 

Use this option to reset scheduler settings to 

default. 

 
 
Tools Menu 
 

Register 

Use this option to register the software after 
purchasing. 

Transfer License 

Use this option to transfer the license of the 

registered software to another computer. 

Update Wizard 

Use this option to check for both, latest minor 

and major versions available online. 

Help 

Use this option to view the help manual for the 
software. 

Buy Now 

Use this option to buy BitRaser for File 
software. 

Support 

Use this option to view the support page of 
stellarinfo.com 

Knowledgebase 

Use this option to visit Knowledgebase articles 
of stellarinfo.com 

Enquiry 

Use this option to submit enquiry to 
stellarinfo.com 

About 

Use this option to read information about the 

 

 

http://www.stellarinfo.com/data-safety-eraser/wipe-professional/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


software. 

 
Application Menu 
 

Tasks 

Use this option to perform different scheduling 

operations. 

Settings 

Use this option to register or update or get 

additional information about software. 

Help 

Use this option to view help menu items. 

Close 

Use this option to exit application. 

 

 

 
Customize Quick Access Toolbar Menu 

Tasks 

Use this option to pin Tasks menu at the top 

pane of screen. 

Settings  

Use this option to pin Settings menu at the top 

pane of screen. 

Help 

Use this option to pin Help menu at the top pane 

of screen. 

Close 

Use this option to close the application. 

 
 

 



Exit 

Use this option to exit application. 

More commands 

Use this option to add a command to toolbar for 

quick access. 

Show Below the Ribbon 

Use this option to move down the Customize 

Quick Access Toolbar. 

Show Above the Ribbon 

Use this option to move the Customize Quick 

Access Toolbar to upper left area of application 

(default location). 

Minimize the Ribbon 

Use this option to minimize the ribbon. 

 
Style Menu 
 
Use this option to switch between various themes 

for the software, as per your choice. 

 

  



Tabs & Buttons 

Tabs 
 

Grid View Tab: Select this tab to list all available 
tabs  in a tabular grid form. 
 

 

Tree View Tab: Select this tab to list all available 
tabs in a tree view pane. 
 

 

System Traces: Click this tab to erase system 
traces permanently. 
 

 

Application Traces: Click this tab to list down 
the supported applications in groups. 
 

 

Internet Activities: Click this tab to erase 
internet traces of supported browsers. 
 

 

Erase Unused Space: Click this tab to erase 
traces of your deleted data,  occupying unused 
space. 
 

 
 

Add Erasure List: Click this tab to manage 
erasure list. 
 

 

Erase Now: Click this tab to erase selected 
drive, files and folders. 
 

 

 
Buttons 
 

 
 

 

Click this button to initiate the erasure process. 

 
 

 

Click this button to remove the available erasure list. 

 
 

 

Click this button to add new list of files and folders to the erasure list. 

 
 

 

Click this button to add the desired files to erasure list. 

 
 

 

Click this button to add a folder consisting multiple files to the erasure list. 



 
 

 

Click this button to save the list. 

 
 

 

Click this button to reload the list items. 

 
 

 

Click this button to apply changes on application. 

 
 

 

Click this button to reset the fields again. 

 
 

 

Click this button to view the list of scheduled task(s). 

 

 
 
Click this button to activate all the deactivated task(s). 

 

 
 
Click this button to deactivate all the activated task(s). 

 

 
 
Click this button to delete all the selected task(s). 

 

 
 
Click this button to reset the scheduler settings. 

 

 
 
Click this button to view all the scheduled task(s). 

 

 
 
Click this button to register the software after purchasing. 
 

 

 
 
Click this button to transfer the license of the registered software to another 
computer. 

 

 
Click this button to update your software. Use this option to check for both, 
major and minor versions of the software. 



 

 
 
Click this button to purchase the software. 

 

 
 
Click this button to submit an enquiry to stellarinfo.com 

 

 
 
Click this button to visit the Knowledgebase articles of stellarinfo.com 

 

 
 
Click this button to open the help manual for BitRaser for File. 

 

 
 
Click this button view the support page of stellarinfo.com. 

 

 
 
Click this button to read more information about the software. 

 
 Back 

 

Click this button to rollback to the previous window. 

 

  



Ordering the Software 

Order BitRaser for File 
To know more about BitRaser for File, click http://www.stellarinfo.com/windows-tools/file-eraser.php 

 

To purchase the software online, please visit http://www.stellarinfo.com/data-safety-eraser/wipe-

professional/buy-now.php 

 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to activate the software. 

  

http://www.stellarinfo.com/windows-tools/file-eraser.php
http://www.stellarinfo.com/data-safety-eraser/wipe-professional/buy-now.php
http://www.stellarinfo.com/data-safety-eraser/wipe-professional/buy-now.php


Registering the Software  

The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of BitRaser for File software. 

2. Click Register option from Tools menu or Home menu. Register window is displayed as shown 

below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) 

or select ’I have the registration key’ (Use this option if you have already purchased the product). 

 

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the window that appears, type the Registration Key and click Register button (Please ensure 

that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

 

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) 

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for 

any reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 



2. A new dialog box will appear. 

3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 

 

4. The software would automatically communicate with the license server to verify the 

entered key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an Internet 

connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 

2. A dialog box will appear displaying Registration ID in its respective field. 



 

3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open BitRaser for File. In Register window, select 'I 

have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key 

is entered. Click OK. 

  

mailto:support@stellarinfo.com


Transfer License 

BitRaser for File allows you to transfer the license of the registered software to another computer on 

which you want to run the software with full functionality. This operation deactivates the product on your 

current computer so it can be reactivated on the new computer. 

To transfer a software license from one computer to another, please follow the specific steps 
below: 

On Target Computer: 

1. Run demo version of the software. 

2. Click Register option from Tools menu or Home menu. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. A dialog box will appear displaying Registration ID in its respective field. 

 

 

On Source Computer: 

1. Run registered version of BitRaser for File software. 

2. Click Transfer License option from Tools menu or Home menu. 

 



3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the 

Source Computer. 

4. To get your License Key, click Transfer In button on Source Computer. This will generate a 

License Key. 

 

5. You can also save the License Key generated on the source computer. Click Save To File button 

to save the Registration ID and the License Key. In Browse for Folder dialog box, select the 

location where you want to save the details. Click OK. 

6. ' License Key has been saved successfully ' message is displayed after the saving process is 

completed successfully. Click OK. 

This will deactivate the product on Source Computer and you will no longer be able to use the software 

anymore on this computer. 

 

On Target Computer: 

1. Type the License Key which you have generated on the Source Computer in the provided field of 

License Key. 

 

2. Click Register to complete the activation process.  

3. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK. 



Updating the Software 
 
Software updates for BitRaser for File software are released by Stellar periodically. To keep the software 

up-to-date it needs to be updated. These updates for the software adds new functionality, feature, 

service, or any other information that can help in improvement of the software. Update option of the 

application is capable of checking for latest updates. This will check for both latest minor and major 

versions which are available online. The minor version of the software can be easily updated through the 

update wizard. However, the major version, if available, has to be purchased. While updating the 

software, it’s recommended to close all the running programs. Note that demo version of the software 

cannot be updated. 

 
To update the application, follow the steps given below: 
 

 Click Update button from BitRaser for File menu bar. 

 Stellar Update Wizard window opens. Click Next. The wizard will search for latest updates, and if it 

finds any new updates, a window will pop up indicating its availability. 

 Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

 Internet connection failure 

 Updates are not available 

Note: If a major version is available, you need to purchase the software in order to upgrade it.  

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar Products. 

 

You can either Call Us or Go Online to our support section at http://www.stellarinfo.com/support/ 

For price details and to place the order, click http://www.stellarinfo.com/data-safety-eraser/wipe-

professional/buy-now.php 

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

 

USA (Tollfree- Pre Sales Queries) 

 

+1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales 

Support 
+31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders  

 

  orders@stellarinfo.com 

 

  

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/data-safety-eraser/wipe-professional/buy-now.php
http://www.stellarinfo.com/data-safety-eraser/wipe-professional/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com
mailto:orders@stellarinfo.com?subject=Purchase%20Order


Erase Selected Volume, Files and Folders 

BitRaser for File provides you with the option to erase selected volume, files and folders directly from 

your computer permanently. 

 

To erase selected volume, files and folders: 
 
1. Run BitRaser for File application. 

2. Click Erase Now tab  from left pane of the screen. All the connected or mapped drives consisting of 

available files and folders are displayed in a tree hierarchy as illustrated below: 

 

 
 

3. Select the Volume, in case you want to erase the full volume. Else, click on the nodes [+] to expand 

and navigate deeper to visit the required files or folders. 

4. Check/Uncheck the files or folders in the tree to select/deselect them for erasure. 

5. Click Erase Now button to start the erasure process. 

  



Erase Traces of Internet Activities 

For each internet activity you make, you risk your privacy. Your hard drive saves sensitive traces of daily 

Internet activities that includes cookies, history, temporary internet files, favorites and auto complete for 

forms and passwords to name a few. BitRaser for File combines Internet traces of supported browsers in 

groups for easy erasure of all their traces. You can select Internet browser (s) to remove all the traces 

and extraneous files created by them. 

 

To wipe traces of internet activities: 

 

1. Run BitRaser for File application. 

2. Click Internet Activities tab from the left pane of your screen. Tab expands showing the following 

supported Internet browsers: 

 

 Google Chrome 

 Internet Explorer 

 Mozilla Firefox 

 Netscape Navigator 

 Opera 

 SeaMonkey 

 Safari 

 Microsoft Edge 

 

  Note that tabs of only installed Internet browsers will be displayed  in enabled mode. 

3. Click on the desired Internet browser, whose activities are to be erased. Application window displays 

the supported Internet browsers and the categories to be wiped/erased in a tree view in the right 

pane of screen as illustrated below: 

 



 

 

4. Check or uncheck the categories to select or deselect them for erasing. Additionally, you can check 

the root node to select all the activities. 

5. In case you are using Tree view, click on +/- sign to expand the tree. Check or Uncheck options 

under the application root node in the right pane to select or deselect the individual traces.  

6. In case you want to navigate back to the previous window, click Back button. 

7. Click Erase Now button from the right bottom of screen to start the erasure process. 

 

Note: Ensure that you have closed all the running instances of application, before initiating the erasure 

process. 



Erase Application Traces 

 
BitRaser for File combines a list of supported applications in groups to make their selection easy for 
erasing traces. You can select application group(s) to remove all the traces and extraneous files 
belonging to that group. The software groups applications under following categories that are sequentially 
described in detail at later stages: 
 

 Email and News Applications 

 Peer to Peer Applications 

 Microsoft Applications 

 Chat Messengers 

 Other Applications 

  



Email and News Applications 

BitRaser for File gives an option to precisely erase selected traces created by E-mail and News 

applications. A list of all the supported e-mail applications in the application group is shown for easy 

selection. Individual traces of specific applications can be selected for cleaning as per your preference. 

 

To clear traces of selected E-mail and News applications: 
 
1. Run BitRaser for File application. 

2. Click Application Traces tab. Tab expands showing the application groups in left pane as illustrated 

below: 

 

 

 

3. Click Email & News Application tab from the left pane of screen. Application window displays the 

following supported applications in a tree view: 

 

 Eudora  

 IncrediMail 

 Mozilla Thunderbird 

 Windows Live Mail 

 



 

 

4. Check or uncheck the supported applications to select or deselect them for erasing their traces. 

Check Select All option to select all the applications under that node. 

 

Note: Note that tabs of installed applications will be displayed  in enabled mode only. 

 

5. In case you are using Tree view, click on +/- sign to expand the tree. Check or Uncheck options 

under the application root node to select or deselect the individual traces. 

6. In case you want to navigate back to the previous window, click Back button. 

7. Click Erase Now button from the right bottom of screen to start the erasure process. 

 

Note: Ensure that you have closed all the running instances of application, before initiating the erasure 

process. 

  



Peer to Peer Applications 

BitRaser for File allows you to precisely erase specific traces created by individual peer to peer 

applications. A list of all such supported applications is provided for easy selection. 

 

To clear traces of selected peer to peer applications: 
 
1. Run BitRaser for File application. 

2. Click Application Traces tab. Tab expands showing the application groups in left pane of the 

screen. 

3. Click Peer to Peer Applications tab. Application window displays the following supported peer to 

peer applications in a tree view: 

 

Ares BitSpirit Imesh 

 

SoulSeek 

BearShare Blubster MP3Rocket uTorrent 

 
BitComet FrostWire 

 

Shareaza Vuze 

 

 

 

4. Check or uncheck the supported applications to select or deselect them for wiping their traces. 

Check Select All option to select all the applications under that node. 

5. In case you are using Tree view, click on +/- sign to expand the tree. Check or Uncheck options 

under the application root node to select or deselect the individual traces. 



6. In case you want to navigate back to the previous window, click Back button. 

7. Click Erase Now button from the right bottom of screen to start the erasure process. 

 

Note: Ensure that you have closed all the running instances of application, before initiating the erasure 

process. 

  



Microsoft Applications 

BitRaser for File provides you with the option to erase unwanted traces created by various Microsoft 

applications. A list of all such supported applications is provided by the software for easy selection. 

 
To clear traces of selected Microsoft applications: 
 
1. Run BitRaser for File application. 

2. Click Application Traces tab. Tab expands showing a list of application groups in left pane of 

screen. 

3. Click Microsoft Application tab. Application window displays the following supported microsoft 

applications in a tree view: 

 

Microsoft 
Access 

Microsoft Info Path 

 
Microsoft Picture 
Manager 

Microsoft Word 

 
Microsoft 
Windows 
Photo Gallery  

Microsoft 
Access 
Snapshot 
Viewer 

Microsoft 
Management 
Console 

Microsoft 
PowerPoint 

Microsoft 
Wordpad 

 

Microsoft Clip 
Organizer 

Microsoft One Note 

 
Microsoft 
Publisher 

Microsoft 
Windows 
Media Player 

 

Microsoft Excel 

 
Microsoft  Paint Microsoft Save 

My Setting 
Wizard 

Microsoft 
Windows 
Movie Maker 

 

 

 

 



4. Check or uncheck the supported applications to select or deselect them for erasing their traces. 

Check Select All option to select all the applications under that node. 

5. In case you are using Tree view, click on +/- sign to expand the tree. Check or Uncheck options 

under the application root node to select or deselect the individual traces. 

6. In case you want to navigate back to the previous window, click Back button. 

7. Click Erase Now button from the right bottom of screen to start the erasure process. 

 
Note: Ensure that you have closed all the running instances of application, before initiating the erasure 
process. 

  



Chat Messenger 

BitRaser for File gives an option to erase traces saved by the supported chat messengers. You can 

erase login time, chats, messages and other sensitive information of your chat messengers. The software 

supports a number of premiere Instant messengers, including Pidgin, Skype, Yahoo Messenger and ICQ.  

 

To clear traces of selected chat messengers: 
 
1. Run BitRaser for File application. 

2. Click Application Traces tab. Tab expands showing the application groups. 

3. Click Chat Messenger tab. Application window displays the supported chat messenger applications 

in tree view as illustrated below: 

 

 

 

4. Check or uncheck the supported messengers to select or deselect them for wiping their traces. 

Check Select All option to select all the applications under that node. 

5. In case you are using Tree view, click on +/- sign to expand the tree. Check or Uncheck options 

under the application root node to select or deselect the individual traces. 

6. In case you want to navigate back to the previous window, click Back button. 

7. Click Erase Now button from the right bottom of screen to start the erasure process. 

 

Note: Ensure that you have closed all the running instances of application, before initiating the erasure 

process. 

  



Other Applications 

BitRaser for File allows you to erase selected traces created by individual applications. The software 

provides a list of all the supported applications in the application group there by providing an ease for 

selection. 

 

To clear traces of supported applications: 
 
1. Run BitRaser for File application. 

2. Click Application Traces tab. Tab expands showing the application groups. 

3. Click Other Applications tab. Application window displays the following supported applications in a 

tree view: 

 

ACDSee  BSPlayer 
 

Google Desktop 
Search 

Picasa 

 

Winamp  

Adobe Acrobat  Corel Paint Shop Pro  Itunes 

 

QuickTime 
Player 

 

WinRar 

 

Adobe 

Photoshop 

 

Divx Player Irfan View 

 

Real Player  

 

Apache Open 

Office 

 

Download Accelerator 
Plus 

Java Runtime Snagit  

Adobe Reader 

 

Free Download 

Manager 

Miro Speed 

Commander 

 

 

Audacity 

 

GetRight Nero Vision WinAce 

 

 
 

 
4. Check or uncheck the applications to select or deselect them for erasing as illustrated below: 

 



 

 

5. In case you are using Tree view, click on +/- sign to expand the tree. Check or Uncheck options 

under the application root node in the right pane to select or deselect the individual traces. 

6.  In case you want to navigate back to the previous window, click Back button. 

7. Click Erase Now button from the right bottom of screen to start the erasure process. 

 

Note: Ensure that you have closed all the running instances of application, before initiating the erasure 

process. 

  



Erase System Traces 

System traces are temporary files that persists in your system even after successful deletion. These files 

are created by the operating system while running a process. System traces occupy memory space that 

degrades the speed and performance of operating system. BitRaser for File deletes all such traces 

thereby improving the speed, performance and memory space of the computer. 

 

To erase system traces: 

 

1. Run BitRaser for File application. 

2. Click System Traces tab from the left pane of your screen.  

3. A list of all the probable system traces is displayed in the right pane of your screen as listed below: 

 

Cached Fonts 
 

List Of Most 
Recently Used 
Files And 
Folders 

Past Items 
From The 
Notification 
Area 
 

Service/Setup 
Log 

Windows 
Event Logs 

Cryptnet URL 
Cache 

List of 
Programs 
From Start 
Menu>Run 
Command 
 

Recent 
Document 

Start Menu 
Programs And 
Favorites 
Menu Order 

Windows 
Explorer 
Stream MRUs 

Diagnostic 
Log 

Map Network 
Drive MRUs 

Recycle Bin System 
History 

Windows 
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4. Check or uncheck the traces to select or deselect them for erasing. Check Select All option to select 

all the traces as illustrated below: 

 



 

 

5. Click Erase Now button from the right bottom of screen to start the erasure process. 

 

Note: Ensure that you have closed all the running instances of application, before initiating the erasure 

process. 

  



Erase Unused Space 

BitRaser for File securely erases all traces of your deleted data that occupy unused space in different 
sections of system's volume. 
 

To erase unused space: 
 
1. Run BitRaser for File application. 
2. Click Erase Unused Space tab from the left pane of screen. All the connected or mapped drives 

consisting of Unused Space are displayed in a tree hierarchy as illustrated below: 
 

 
 

3. Select the desired system volume to initiate the erasure process for its unused space. In case you 
are using Tree view, click on +/- sign to expand the tree. 

4. Check Select All option to select all available system's volume. 

5. Click Erase Now button to start erasure process. 



Add Erasure List 

 
BitRaser for File permanently erases extraneous files in order to prevent recovery of sensitive data that 

is no more required. These unwanted files and folders are a threat to privacy or security. At times it 

becomes too difficult to erase multiple files and folders at a single instance. The software serves as a 

solution by linking all such files and folders to a list so that they can be erased in a single go. BitRaser 

for File gives an option to create, remove, edit or save list of items and tasks that must be erased from 

time to time efficiently. 

 
 Add New List 

 Remove List 

  



Add New List 

BitRaser for File gives an option to erase a list of specified files or folders, present in the system. List of 

multiple files and folders can be erased in a single step. Additionally, you can also save this list in the 

application for future reference. 

 

To erase the files and folders of a saved list, follow these steps: 
 
1. Run BitRaser for File application. 

2. Click Add Erasure List tab from the left pane of screen. In case you have any saved erasure list(s), 

it will be displayed in the application window as illustrated below: 

 

 

 

3. Click Add New List button from the bottom right pane to add new list of files and folders in the 

Erasure List. 

4. In the Add new List window that opens: 

 

 Click Add File button to add the desired files to erasure list. 

Or, 

 Click Add Folder button to add the desired folder consisting of multiple files to the erasure list. 

 

5. In case you want to add files from an existing list, click Load List button. 

6. Click Save List button. A dialog as illustrated below opens: 

 



 

 

7. Enter the list name and click on Save button to save the current list. 

8. Select the list(s) that are to be erased. Check or Uncheck options are available to corresponding lists 

to select or deselect the individual traces. Click Select All to select all the lists for erasure. 

9. In case you want to navigate back to the previous window, click Back button. 

10. Click Erase Now button to start the erasure process. 

 

To add folders to the erasure list: 

 

1. Click Add Folder button. A dialog box is displayed as illustrated below: 

 

 

 

2. Click Browse button to select folder consisting multiple files in Browse for Folder dialog box. 

 



 

 

3. Type file types separated by semi-colons, that you want to exclude from the erasure process. Note 

that only these file types will be excluded while others will be erased from the erasure process. 

4. Select Erase Sub Folders check box to delete files of all the corresponding sub folders. 

5. Select Delete Folder After Erasing Content check box to remove the folder after erasing the 

related files. 

6. Click OK to proceed. 

  



Remove List 

BitRaser for File provides you with the option to remove erasure list, you can either remove individual 

files or folders from a list or you can delete the list itself in one go. Items once erased, are non-

recoverable in nature. 

To remove erasure List 
1. Run BitRaser for File application. 

2. Click Add Erasure List tab from the left pane of screen. All the saved lists are displayed in the 

application window as illustrated below: 

3. Select the desired list, you want to remove. Note that you can also remove selected files/folders from 

an erasure list. 

4. Click Remove List button from the bottom right pane to remove existing list of files and folders in the 

erasure list. 

5. A Deletion confirmation dialog opens, Click Yes to confirm. 

 

 

 

Erasure list will be successfully removed from the application. 

To remove individual file(s)/folder(s) from erasure list 
1. Click Add Erasure List tab from the left pane of screen. All the saved lists are displayed in the 

application window as illustrated below: 

 



 

 

2. Double click the list containing the file(s)/folder(s), you want to remove. Note that you can also 

remove entire list at one go. 

3. In the next window that appears, select the file(s)/folder(s) to be removed .Click Select All to select 

all the  files/ folders present in the list for erasing. 

4. Click Remove From List button to permanently delete the selected file(s)/folder(s). 

5. Click Save button to proceed. 

  



Search File 

BitRaser for File gives an option to search specified files present in the system. Using Search File by 
Name option, you can search for multiple files in your computer's drives, folders and sub folders. 
Additionally, you can also search for a specific file using its extension in case you don't remember file 
name. 
 

To search files, follow these steps: 
 
1. Run BitRaser for File application. 

2. Click Search File tab from the left pane of screen. 

 

 

 
3. Click Search File by Name option. A window opens as shown below. 

 



 

 
4. In Search File field, type the name or extension of file you want to search. Click Add File button. 

5. The file name or extension is added to the search list. Follow the above steps if you want to add 

multiple files to search list. 

 
Note:  Click Remove From List to remove selected file from the search list. 

Click Remove All button to remove all the files added in the search list. 

 
6. From Search in field, select the drive/folder from which you want to search your file. Click Exact 

Search option if you want to refine your search. This option shows the files only when a user types 

the exact file name with extension in the search file list.  

7. Click Search. After the search is finished, a list of files found in the selected drive is shown as 

displayed below. 

8. From the search result, select file(s) that are to be erased. Check or Uncheck options are available to 

corresponding files to select or deselect the individual traces. Click Select All to select all the files for 

erasure. 

 



 

 
9. In case you want to navigate back to the previous window, click Back button. 

10. Select Create Certificate option if you want to generate a certificate for the erasure process. 

11. Click Erase Now button to start the erasure process. 



Set Erasure Schedule 

 
The software allows you to set schedules as a sequence of events for erasure activities. You can perform 

various scheduling tasks mentioned below that are described in detail at the later stages of manual: 

 

 Set Scheduler 

 View Schedule Tasks 

 Change Schedule State 

 Delete Scheduled Tasks 

 Reset Scheduler 

  



Set Scheduler 

BitRaser for File gives an option to preset specific tasks to run at a predefined date and time. User can 

choose from a list of files and memory space to erase in the application at a preset time. 

To set the scheduler: 
1. Run BitRaser for File application. 

2. Click Schedule tab. 

3. Select the erasure activities that will be performed at the scheduled time from left pane of screen. 

Click on root node to select or unselect all options in that node. 

 

 In Internet Activities root folder, select the web browsers. Traces left by the selected browsers will 

be deleted. Click on the web browser root folder to expand the tree. Select the internet activities 

that you want to erase at the scheduled time. 

 In Application Traces root folder, select the applications groups to erase all the traces created by 

any application in that group. You can expand the tree to choose the specific application to erase 

any trace created by it. 

 In System Traces root folder, select the unused traces that are to be erased. 

 In Erase Unused Space root folder, select the unused traces from the system's volume. 

 In Add Erasure List, all the available erasure lists will be displayed in a tree pane. Select the 

desired erasure list to be deleted at the scheduled time. 

 

 

 

4. Select Start Date of scheduler from right pane of window. Scheduler will start on this date. 

5. Select Start Time of scheduler from right pane of window. Scheduler will start at this time. 



6. Select Show Mode radio option to display the scheduler at running time on screen. 

Or, 

Select Hide Mode radio option to hide the scheduler at running time. Note that the running instance 

of scheduler is displayed in the taskbar. 

7. Select the desired Erasure Algorithm and Verification Method from Advance Option section. 

8. To Set Frequency: 

 

 Select Once to run scheduler once. 

 Select Every Day to run scheduler daily. 

 Select Every Week to run scheduler every week. 

 Select Every Month to run scheduler every month. 

 Select Every Boot to run scheduler at every startup. 

 Select First boot of the Day to run scheduler when system is started for first time daily. 

 

9. Click Apply button to save the schedule settings. In case you want to set the scheduler to default 

settings, click Reset button. 

10. To view the list of all scheduled tasks, click Scheduled Tasks button. 

  



View Schedule Tasks 

BitRaser for File allows you to view a list of all available scheduled tasks and their details like status, 

state, algorithm, mode and frequency to name a few. 

To view scheduled tasks: 
1. Run BitRaser for File application. 

2. Click Schedule tab. 

3. Click Scheduled Tasks View option from menu bar. A Schedule Task window opens at the right 

pane of screen with following fields: 

 

Fields Description 

Name This field displays the default name assigned to task by BitRaser for File.  
 

Status 
 

This field displays the current status of task. 

State This field displays the schedule state of task as either activate or deactivate. 
 

Algorithm 
 

This field displays the algorithm applied on respective task. 

Passes This field displays the corresponding passes for the selected algorithm. 
 

Verification This field displays the verification method applied on task. 
 

Mode 
 

This field displays the mode as either show or hide depending upon the initial 
selection. 
 

Frequency 
 

This field displays the frequency of scheduled task. 

Triggers This field displays the date and time of the consequent scheduled task. 
 

Next Run 
Time 
 

This field displays the time when the respective task will be executed. Next Run 
Time depends upon the frequency of task. 

Last Run 
time 
 

This field displays the last run time when the task was executed. 
 

Author 
 

This field displays your computer name. 

Created 
 

This field displays the date and time of task creation. 

 
4. Click Refresh button to reload the schedule task list. 

5. Click Change State button to change the state of schedule. 

6. Click Delete button to remove a scheduled task from list. 

  



Change Schedule State 

Once a schedule has been assigned, you can change its state from activate to deactivate and vice versa. 

Note that you can change state for a selected list of schedules or for all assigned schedules of application 

at one go. 

To change state of selected scheduled erasing task: 
1. Run BitRaser for File application. 

2. Click Schedule tab. 

3. Click Scheduled Tasks View option from menu bar. A Schedule Tasks window opens at the right 

pane of screen as illustrated below: 

 

 
 
4. Among all the listed schedules, select the appropriate schedule to change its state. 

5. Click Change State button from the bottom right pane of screen to change its state from activate to 

deactivate and vice versa. 

6. In a dialog that appears confirming change in state, click Yes to continue. 

To change state of all scheduled erasing tasks: 
1. Run BitRaser for File application. 

2. Click Schedule tab. 

3. Click Activate All Tasks option from schedule menu bar to activate all assigned erasure schedules 

of application. An Activate all Task(s) dialog prompts. 

Or. 

Click Deactivate All Tasks option from schedule menu bar to deactivate all assigned erasure 

schedules of application. A Deactivate all Task(s) dialog prompts. 

4. Click Yes to continue. 

  



Delete Scheduled Tasks 

Tasks once scheduled for erasing, can be easily removed from scheduled list. Note that by removing 

such tasks from scheduled wiping list, you delete it from BitRaser for File application permanently. The 

software also provides you with the option to remove all scheduled tasks at one go. 

To delete scheduled tasks: 
1. Run BitRaser for File application. 

2. Click Schedule tab. 

3. Click Scheduled Tasks View option from menu bar. A Schedule Tasks window opens at the right 

pane of screen. 

4. Among all the listed schedules, select the desired schedule. Click Delete button to remove it from the 

scheduled list. 

5. A dialog appears confirming deletion as illustrated below, click Yes to continue. 

 

 
 

6. In case you want to delete all the available tasks from scheduled task list at one go, click Delete all 

Tasks button from Schedule menu. 

  



Reset Scheduler 

Once a schedule has been set for a specified erasure task, you can remove the changes and reset your 

scheduler settings to default. The erasure schedule is reset as it was before you made the changes. 

To reset scheduler: 
1. Run BitRaser for File application. 

2. Click Schedule tab. 

3. Click Reset Scheduler option from menu bar. A Warning dialog prompts as illustrated below: 

 

 
 

4. Click Yes to continue. Scheduler will be reset to default settings of application. 

  



View and Save Log Report 

You can view, clear and save log report of erasing activities performed in BitRaser for File. All activities 

recorded since the application was installed are displayed in log report. Log report is saved as text file at 

specified location. 

To view and save log report 
 Click Tools menu from the menu bar, select Logs tab from upper right pane of the screen. 

 Click View Log button to display the log information. 

 A dialog box containing log report opens as shown below: 

 

 

 Click Clear button from BitRaser for File Log View dialog to clear log report. 

Or, 

Click Clear Log button. 

 Click Save and choose location for saving log report in Save Log Report dialog box. It will be saved 

at the specified destination. 

  



Set Algorithm for Erasing 

BitRaser for File enables you to choose a erasing algorithm from a list of 17 provided algorithms. Also, 3 
verification options are available to you in order to ensure that the data has been erased permanently and 
is no longer recoverable. 

 
You can select a Erasing Algorithm and a Verification Method from Select Algorithm For Erasing tab of 
Tools menu. 
 

Erasing Algorithm 
 

Erasing Algorithm Description 

Zeroes This algorithm erases data by overwriting it with zeroes in a single pass. 
This is the fastest algorithm available to a user.  
 

Pseudo-random 
 

This algorithm erases data by overwriting an entire hard drive with 
randomly generated numbers in a single pass. 
 

Pseudo-random & 
Zeroes (2 passes) 

This algorithm erases data by overwriting the hard drive in two passes. In 
first pass, it overwrites data with randomly generated numbers and in 
second pass it overwrites the previously generated data with zeroes. 
 

Random Random Zero 
(6 passes) 
 

This algorithm erases data by overwriting a storage media with random 
characters in a multiple passes. 

US Department of 
Defense, DoD 5220.22-
M (3 passes) 

This algorithm erases data by overwriting the hard drive in three passes. In 
first pass, it overwrites data with zeroes, then in second pass, it overwrites 
the data with ones and finally in the third pass overwrites the data with 
randomly generated bytes. 
This is a U.S. Department of Defense algorithm. 
 

US Department of 
Defense, DoD 5200.22-
M (ECE) (7 passes) 

This algorithm erases data by overwriting the hard drive in seven passes. 
The first, fourth and fifth pass is overwriting with a random byte, its 8 right-
bit shift complement and 16 right-bit shift complement; second and sixth 
passes are overwriting with zeroes, and third and seventh pass with 
random data. 
This is a U.S. Department of Defense algorithm. 
 

US Department of 
Defense, DoD 5200.28-
STD (7 passes) 
 

This algorithm erases data by overwriting the hard drive in seven passes. 
In first two passes, it overwrites data with certain 
bytes and their complements, then in next two passes it overwrites data 
with random characters. In fifth and sixth passes, it overwrites data with a 
character and its complements and finally, it overwrites data with random 
characters. 
This is a U.S. Department of Defense algorithm. 
 

 Russian Standard - 
GOST-R-50739-95 (2 
passes) 
 

This algorithm erases data by overwriting the hard disk with zeroes 
followed by a single pass of random characters. 

B.Schneier's algorithm 
(7 passes)  

This algorithm erases data in seven passes. In the first two passes, it 
overwrites the hard disk with ones and then zeroes and in next five 
passes, it overwrites data with random characters. 



 

German Standard, 
VSITR (7 passes) 

This algorithm erases data by overwriting data with three alternating 
patterns of zeroes and ones and then a last pass which overwrites data 
with random characters. 

Peter Gutmann, (35 
passes) 

This algorithm erases data by overwriting it 35 times, making recovery of 
the wiped data by any tool impossible. This algorithm takes more time than 
other wiping algorithms. 
 

US-Army AR 380-19 (3 
passes) 
 

This algorithm erases data by overwriting the media in three passes. In the 
first pass, it overwrites data with random bytes, then in second and third 
pass, it overwrites data with certain bytes and their complements. 
This is a U.S. Army algorithm. 
 

North Atlantic Treaty 
Organization-NATO 
Standard (7 passes) 
 

This algorithm erases data by overwriting the media in seven passes. 
From pass one to six, it overwrites the data with a number and its 
complement alternatively. Then, in the final pass, it overwrites data with 
random characters. 

US Air Force, AFSSI 
5020 (3 passes) 
 

This algorithm erases data by overwriting the media in three passes. First, 
it overwrites with zeroes, then with ones and finally with random 
characters. 

Pfitzner algorithm (33 
passes) 
 

The Pfitzner algorithm is a used in file shredding and data destruction 
programs to overwrite existing information on a hard drive or other storage 
device. All the passes in Pfitzner method consists entirely of random 
overwriting of data in the storage device. 

Canadian RCMP 
TSSIT OPS-II (4 
passes) 
 

This algorithm is a four pass overwriting algorithm with alternating patterns 
of zeroes and ones and the last pass - with a random byte. 

British HMG IS5 (3 
passes) 
 

This algorithm is a three pass overwriting algorithm, first pass - with 
zeroes, second pass &endash; with ones and the last pass with random 
data. 

 

Verification Method 
 

Verification 
Methods 

Description 

No Verification 
 

No verification is done after the traces are erased. 
 

Random 
Verification 
 

Random verification of the storage device is done after the erasing operation, that 
is, randomly selected sectors of the storage device are verified after erasing 
operation. 

Total 
Verification 
 

Total verification verifies all the sectors of the storage device after the erasing 
operation is completed. 

  



Set Password Protection 

BitRaser for File provides you with an option to apply password protection on your application. This 

feature prevents you against unauthorized access to your application. 

To set password protection: 
1. Run BitRaser for File application. 

2. Click Tools tab. 

3. Among the 3 tabs that are displayed in the right pane of screen, select Advanced tab. 

4. Click Create Password Protection link to set a password protection to your application.  

5. Type a password of minimum 6 digits in Enter Password text box. 

6. Retype the password in Confirm Password text box as illustrated below: 

 

 
 
5. Click Apply button to proceed.  

 
Password will be applied on BitRaser for File.Once you have successfully applied password you will see 

2 links on the right pane of your screen as illustrated below: 

 



 
 
To change Password 
 
1. Click Change Password link to set a new password to your application. 

2. Enter your Current Password. 

3. Type the New Password you want to set as an encryption to your application. 

4. Retype the password in Confirm Password. 

5. Click Apply button to proceed. 

 

The application will set new password as your current password. 

 
To remove Password 

 

1. Click Remove Password link to delete password protection from your application. 

2. Enter your Current Password as illustrated below: 

 



 
 

4. Click Apply button to proceed. 

 

Password protection will be removed from BitRaser for File. 

  



FAQs 

1. Why do I need BitRaser for File? 
 

Data once deleted, is not removed from the hard drive completely. Unwanted links and information 

can be recovered back. BitRaser for File uses different techniques and algorithms to erase 

unwanted information and links there by making the data unrecoverable. 

 
2. Is it safe to use BitRaser for File application for erasing unused space of my hard drive's 

primary partition? 
 

Yes, it is secure to use BitRaser for File to erase unused space of hard drive's primary partition as it 

only removes the unused space left after deletion of files and folders, leaving the data untouched. 

 
3. What if data of the application traces is not erased after complete erasure process? 

 
It happens in case, you have not closed the application during erasing process or if you are viewing 

newly created files and folders after the application has restarted on completion of an erasure 

process. 

 
4. Can I erase a specific file using the application? 

 
Yes, you can erase some specific files by adding them to the erasure list or you can also erase 

selected files through Erase Now option. 

 

5. Does BitRaser for File removes data beyond recovery? 
 

   Yes, BitRaser for File removes data beyond recovery. 

 
6. What if the data of System Traces are not erased after completion of an erasure process? 

 
This problem arises in case you are viewing the recently created files or folders, as the Operating 

System automatically creates some system traces at different time intervals. 

 
7. Which algorithm should I choose for best erasure? 

 
It depends upon how many times an algorithm overwrites the data precisely or the number of passes 

used to erase the data. More the number of passes used by the algorithm, more effective it is. Each 

algorithm performs different set of features from where you can choose the suitable algorithm as per 

the requirement. 

 

8. What if the application is taking too long to erase the data? 
 



It depends on the size of the data you are erasing, configuration of the system and the algorithm you 

are using to erase the data. A large amount of data, lesser configuration and more number of passes 

may consume more time for erasure. 

 
9. I don't want to clear all my Internet activities. How can I do that? 

 
BitRaser for File provides you with an option of erasing all or some specific traces of Internet 

Activities. 

 
10. Is it possible to erase all the traces of supported applications and system traces at the same 

time? 
 

The software has an option to erase all traces of your system at one go, by simply clicking on Erase 

All Now button. 

 
11. Does BitRaser for File has any password protection facility? 

 
    Yes, you can protect your application by applying a password to your application. 

  



Legal Notices 

Copyright 
 
BitRaser for File software, accompanied user guide and documentation are copyright of Stellar 

Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user guide 

cannot be reproduced in any form without the prior written permission of Stellar Information Technology 

Private Limited. No Patent Liability is assumed, however, with respect to the use of the information 

contained herein. 

 

Copyright © Stellar Information Technology Private Limited. INDIA. 

 
Disclaimer 
 
The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

 
Trademarks 
 
BitRaser for File® is a registered trademark of Stellar Information Technology Private Limited.  

Windows XP®, Windows 7®, Windows 8® and Windows 10® are registered trademarks of Microsoft® 

Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their 

respective companies. 

 



License Agreement 
 

BitRaser for File 

Copyright © Stellar Information Technology Private Limited. INDIA. 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of BitRaser for File. 

 

Your Agreement to this License 

 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of BitRaser for File with which this License is included, you may return the complete 

package unused without requesting an activation key within 30 days after purchase for a full refund of 

your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

BitRaser for File. For purposes of this License, if you have a valid single-user license, you have the right 

to use a single Licensed Copy of BitRaser for File. If you or your organization has a valid multi-user 

license, then you or your organization has the right to use up to a number of Licensed Copies of BitRaser 

for File equal to the number of copies indicated in the documents issued by Stellar when granting the 

license. 

 

Scope of License 

 

Each Licensed Copy of BitRaser for File may either be used by a single person or used non-

simultaneously by multiple people who use the software personally installed on a single workstation. This 

is not a concurrent use license. 

 

All rights of any kind in BitRaser for File, which are not expressly granted in this license, are entirely and 

exclusively reserved to and by Stellar Information Technology Private Limited. You may not rent, lease, 

modify, translate, reverse engineer, decompile, disassemble or create derivative works based on BitRaser 

for File nor permit anyone else to do so. You may not make access to BitRaser for File available to others 

http://www.stellarinfo.com/


in connection with a service bureau, application service provider or similar business nor permit anyone 

else to do so. 

 

Warranty Disclaimers and Liability Limitations 

 

BitRaser for File and all accompanying software, files, data and materials are distributed and provided AS 

IS and with no warranties of any kind, whether expressed or implied. You acknowledge that good data 

processing procedure dictates that any program including BitRaser for File must be thoroughly tested with 

non-critical data before there is any reliance on it and you hereby assume the entire risk of all use of the 

copies of BitRaser for File covered by this License. This disclaimer of warranty constitutes an essential 

part of this License. 

 

In addition, in no event does Stellar authorize you or anyone else to use BitRaser for File in applications 

or systems where its failure to perform can reasonably be expected to result in a significant physical injury 

or in loss of life. Any such use is entirely at your own risk and you agree to hold Stellar harmless from any 

and all claims or losses relating to such unauthorized use. 

 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

 

General 

 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 



About Stellar 
 
Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

 

Product line: 

 

Data Recovery 

 
A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

 

File Recovery 

 
The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

 

E-mail Recovery 

 
A wide range of e-mail recovery, e-mail repair and e-mail conversion applications for MS Outlook, MS 

Outlook Express and MS Exchange useful in instances of data loss due to damages and corruption of E-

mail. More Info >> 

 

Data Protection 

 
A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/database-recovery.php
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm


Data Sanitization 

 
Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

For more information about us, please visit www.stellarinfo.com 

http://www.stellarinfo.com/windows-tools/file-eraser-mac.php
http://www.stellarinfo.com/

